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Learning Objectives
•
•
•
•

BIM 360 Design workflow
Integration of Design and Construction
Understanding of Autodesk Forge
Future of cloud technology

Description
"In the early days of CAD, it was 2-dimensional creation of design. Then came the era to create
models in 3D. Now, the next phase of change is era of connected BIM. This era is about
building applications and solutions that connect a community of people to a project or product,
to the new means of production. In this era, you can optimize a design not only for how it
functions but for how it is built and interconnects with other systems and that too on cloud. This
class will showcase how users can utilize the power of cloud using Autodesk Revit and BIM
360. It will also showcase how the users can customize the information present in BIM 360
using Autodesk Forge and make their own customized apps."
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Speaker(s)
Shashwat Bhardwaj
Linkedin

I am a Structural Engineer with experience in the power plant industry
and residential projects. Diligent in establishing BIM protocols including
development, training, and consultation. Worked as a key adoption
person in his earlier Organization which was going through a transition
phase from 2D to 3D.
Currently, as the key point of contact for AEC Technical support in Autodesk for APAC and
EMEA region, I have helped many Autodesk Enterprise Priority customers, most of them related
to diverse AEC products Autodesk Forge, BIM 360, Revit, Navisworks, etc.. Working for the EP
accounts, I have also focused on finding the root cause of the problem, apart from
troubleshooting which has helped in quicker resolution of repetitive cases, which is why I am
currently BIM 360 Q/A Lead in APAC in Global Product Support Team. I am a charted civil
engineer and is fascinated by buildings and structures.
I love driving and off roading on my bike. I love cooking and taking pictures with my DSLR
wherever I go.

Shruti Gupta
Linkedin

I have been a part of the Architecture and construction industry for 5
years. After graduating as a civil engineer, I worked in a prestigious
Indian company called Tata Consulting engineers, designing structural
buildings for power plants. Realizing the potential of software
integration, 3D revolution, and BIM in the construction industry, I
became a part of the adoption team in my organization, gaining the
technical skills required for the same.
I joined Autodesk as an Enterprise Priority Support specialist in May 2018, to provide support for
Revit and Navisworks. Fascinated by BIM 360, I learned the product and started providing
support for the same. Currently, I support Assemble, Robot Structural Analysis, and Structural
Bridge Design, in addition to the above three.
In my free time, I love to travel and read. Lazy and relaxing holidays are my guilty pleasures. I
firmly believe in giving back to society to make this world a better place.
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Introduction
What is the idea behind this class?
Human beings are natural builders. The need for shelter has motivated us to construct our
houses and eventually other structures over the years since the ‘Stone Age’. Building something
has significantly changed over the years, but one thing has remained constant: The idea of
concept to creation.
How humans shared their idea? In the early days, it was communicated verbally. As humanity
developed, slowly the mode of communication evolved. It took approx. 10,000 years from
writing to printing press and roughly around 500 more for an email to come. We have seen an
era where 2D hand-sketched drawings communicated that concept. Then with the change in
technology the computer-aided design came around early 19th century. We are in a time where
the concept can be visualized beforehand using the 3D models. And the future beholds an era
where the concept to creation cycle will be hosted on a cloud so that the most relevant concept
or idea is not geographically constrained, and the construction becomes an even process.
This class is created to connect the dots between the 3D technology and the cloud technology
with the help of Autodesk tools.

Why shall I attend the class?
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Visualization of design is something that we are all aware of, but the incorporation of cloudconnected data and data analytics in this area and then eventually customization of the data is
something that you might want to try hands-on.

This lab promises three takeaways:
•
•
•

The present understanding of the BIM scenario with the help of BIM 360 Design
workflow
Connecting data from site/ field to design, and analysis of this data to understand
the project statistics.
Usage of Forge to understand how in the cloud the BIM data is stored.
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Learning Objective 1 – “BIM 360 Design Workflow”
Building Information Modeling (BIM) is a process that begins with the creation of an intelligent
3D model and enables document management, coordination, and simulation during the entire
lifecycle of a project (plan, design, build, operation and maintenance).
This section will cover the following learning objectives:
1) Creating BIM 360 project and setting up teams
2) Collaborating Revit model with BIM 360
3) Using BIM 360 Design workflow to share/ consume data from other teams.
Autodesk® BIM 360™ improves project delivery by supporting informed decision-making
throughout the project lifecycle for the project, design, and construction teams.
Note: This part is optional for users who have already set up the Project in BIM 360. They can
directly go to Step 2.

Step 1) Creating Project in BIM 360
1. Go to Account Admin module in BIM 360

a. If you do not have access to BIM 360 Design, then kindly refer this article to
access free trial of BIM 360.
2. Go to Projects Tab
3. Click on Add and a new window will open to fill Project Profile
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4. Fill all necessary details like Project Name, Project Type, Project Start Date, Project End
Date, and BIM 360 Field Project language.
Details for this project:
Project Name: Autodesk University Project X
Project Type: Data Centre
Construction Type: New Construction
The rest of the details can be filled by your choice.
5. Click on Save and Continue
6. A new window will open with the new project and the Project Admin module opened.
7. Under Services tab, activate the services, Document Management, Design Collaboration
and Field Management one by one.
Note: To know more about the activation of services, refer the document here.
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8. Once you click on the Activate button for service BIM 360 Document Management, you will
be directed to a page where you can select any project template.
In this project, we will not use a project template and click on “Don’t apply a
project template”

9. Assign Project admin for the Document Management service and all other services that you
have activated.
10. Click on Finish.
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Step 2) Inviting Project members
1. Click Add.

2. In the Add Project Members field, start typing a member's name if that person is already in
the account.
3. Click on the member email from the available options on the drop-down menu.
Note: To add a member who is not already in the account, enter that person's email
address in the Add Project Members field.
4. Click Select.
Note: The list of added members will display the project member status of someone who
was previously added.
5. Repeat steps 2 - 4 to add multiple members to a project at the same time.
6. Click Add to Project. This generates an email notification to members to activate their
membership and access the project.
Note: In this case, we have added two members, Shashwat Bhardwaj (Project Admin) who is
from the Architecture team, and Shruti Gupta (Member) who is from the Structural team.

To learn more about controlled access to users (Specific permissions) who are invited, please
refer this document.
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Step 3) Creating folders in BIM 360 Document Management
Every project starts with pre-configured top-level folders to support a specific process or data
type. These folders are called Plans and Projects Files. You can add subfolders to these
folders.
To learn more about them, refer: Plans and Project Folder
Note: We will be creating folders under “Project Files” as ‘Plans’ folder does not support Design
Collaboration service.
To Add Folders:
1. In the folder tree, right-click a folder and click Add Subfolder. A new folder appears
below the parent folder.
2. Enter a name As “Architecture” and press Enter.
3. Follow step 1 and create another subfolder with the name “Structure”.
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Step 4) Creating Teams in BIM 360 Design Collaboration
•
•
•

Teams are created to represent a company or a specific function within a company. For
example, there might be different teams for architects, structural engineers, mechanical
engineers, and so on.
Members can share data using the Shared and Consumed folder. These folders are
essential for data exchange and shall not be deleted.
Before adding teams and managing team members, it's important to understand what
happens between Design Collaboration and Document Management when a team is
added. To do this, consider the following example in which two teams were added;
Team A and Team B.

•

We see the two teams on the project timeline in Design Collaboration:

•

We also see new Shared and Consumed folders for the two teams in Document
Management:
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•
•

All these folders are created when you add teams using Project Admin for Design
Collaboration.
The Shared folder and its sub-folders for each team represent the shared space for all
teams. The Consumed folder and its parent team folder represent the Team Space for
each team.

To create Teams:
1. Go to Project > Project Admin Module > Services
2. In the Services tab, go to Design Collaboration under the menus given on the left side.
3. Click on “Add Team” to create teams.
Note: There will be an option if we want to select the default location for the Shared folder or a
different folder. At this point, we will be selecting “Use default Location’/Project files/ Shared’
4. A window will appear to enter the name of the team. Below is a small notification stating: “If
you have already created folders to represent teams, you can select them here”
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5. Click on here.

6. Select the folder “Architecture” under Project files and click on Add Teams
7. The team will be created. Click on Close to complete the process.
8. Follow the same stems from 3-6 to create another team named “Structure”
This is how the teams will look like:
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Step 5) Get Project Models into Collaboration for Revit
Note:
• As of April 9, 2018, Autodesk® Collaboration for Revit® service is now Autodesk® BIM
360™ Design, a new cloud worksharing, data management, and collaboration solution
built on BIM 360.
•

The service currently named Revit Cloud Worksharing, as part of the product BIM 360
Design, was formerly called Collaboration for Revit (C4R). A BIM 360 Design
Subscription is required to access this service

In order to check if the BIM 360 Design entitlement is provided to you or not, refer below:
How to check if you have a BIM 360 Design entitlement

To Initiate the Revit cloud worksharing for model Architecture.rvt
1. Open the model, “Architecture project” from the dataset that has been provided, in Revit
2020.
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2. To create a new set, in the Publish Settings dialog, click (New Set). Enter a name for the set
and click OK.

3. Select 1 3D view and a 2D sheet (already existing)
Note: To know more about Publish settings, refer this document from Revit help.
4. Click Collaborate tab Manage Collaboration panel
Collaborate in Cloud. There will
be an option to select Within your network or BIM 360 Document management.
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5. In the Collaboration in Cloud dialog, if desired, rename the model.
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6. Select a cloud project (BIM 360 Project) that we have created and go to the Project files>
Architecture and click OK.
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7. In the Collaboration in Cloud dialog, click Initiate. Revit displays information about the status
of the initiation process.

8. Click Close to continue.
Follow the same steps mentioned above for model Structure.rvt.
Now, these models will be visible in the BIM 360 Document Management web browser.
Note: For more details around Revit cloud worksharing refer this link.
For Best practices, you can also refer this document.
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Step 6) Design collaboration workflow
There are three methods available to share Revit models with other project teams using BIM
360 Design. These methods offer flexible ways for other teams to access your models.
1. Controlled Sharing - Consume Models from Packages
2. Controlled Sharing - Link from the Shared folder
3. Live Linking
In this lab we will use the first workflow- ‘Controlled Sharing - Consume Models from Packages’.
To learn more about other two methods, click on the link here.
The basic workflow can be described using the below image:

To understand more about the workflow, refer Choosing a collaboration workflow with BIM 360
Design
1. Go to Design collaboration module in BIM 360 project
2. Go to the Architecture team from the BIM 360 Design timeline.
Note: To know more about timeline symbols, refer the document here.
3. Click on the + button to Create a new package.
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4. Include the ‘Architecture.rvt’ model from the models dropdown and click on Save.
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5. Click on “Share” to share the newly created package. A dialogue box will appear to
name the package and add description if required.

6. As a member of Structure team, go to the team from the timeline. You will be able to see
the package shared by the Architecture team from the timeline.

7. Click on the Package and click on Consume to consume the package from Architecture.
Once you do that a dialogue box will appear to mention that we are about to consume
model from another team space.
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Click on consume again.
8. Go to the Structure team to create a new package and include the ‘Structure.rvt’ model
and follow the same steps 3 to 7 for Structure team.
At this point, both the teams have other team’s model in their respective consumed folder. This
is how the folder structure will look like:
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Linking the model from the Consumed folder:
For Architecture Team:
1. Open the now workshared model again in Revit 2020 from Revit home page (Ignore this
step if already opened)
Note: You can refer this document to understand more about Revit home page.
2. Go to a floor plan/ 3D view and click on “Manage Links”

3. Click External Resource in the left panel of the file browser.

4. Navigate to the location of the cloud model, which is Architecture< Consumed<
Structure< Structural Project.rvt
5. Select the model and click Add and OK
6. Once linked, synchronize the model and close the revit file.
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To publish the latest version of a model from the Model Browser (recommended)
1. Click (Home) on the Quick Access toolbar or press CTRL+D to switch to Revit Home.
2. Click the BIM 360 link to navigate to a cloud project that contains Revit cloud
workshared model.
3. Single model: On the right, click [ …], and click Publish Latest.

4. The Publish Status, Published Date, and Published By columns are updated.
7. To view the published models, click the BIM 360 project link.
This will make sure you are able to see the Structural model linked in your file. You can do the
same for the structural team.
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Learning Objective 2- ‘Integration of Design and Construction’
This section will allow us to dive into BIM 360 Field Management, a tool that can be helpful in
construction sites for capturing field data.
With Field Management, your team can perform construction quality, safety, punchlist, and
equipment commissioning workflows.
Note: The Field Management service is not available on BIM 360 Design trial.
This section will cover the following leaning objectives:
•
•
•

Use of BIM 360 Field Management to create checklists and issues
Overview of Construction IQ which uses this data to manage risk and improve
performance.
Use of Data Connector to import the BIM 360 data to Power BI for data analysis

Step1) Providing permissions to specific members in Field Management
The permissions can be set individually for templates, checklists, and daily logs.
1.
2.
3.
4.

Go to the Project Admin module.
Click the Services tab.
Select Field Management in the panel on the left.
Select the Checklists or Daily Logs tab to modify permissions.
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For Issue permissions:
1.
2.
3.
4.

Go to the Project Admin module.
Click the Services tab.
Select Issues in the panel on the left.
Use the search box to select the users, roles, or companies you want to modify
permissions for.

Tip: You can select multiple users, roles, and companies, and then specify the same permission
level for them all in bulk.
5. Use the drop-down menu to modify the permission level for the selected users, roles,
and companies.
6. Click Add.

Note: Permissions can't be changed for other administrators. Project administrators have full
control by default. If an individual has higher permissions than their role the higher permission
set is used.

In this case, as we are two members as Project admins, we have full control in Field
Management. To know more about permissions, click on the help document here.
1. Template Permission: Full Control- Members can create and import checklist
templates. They can edit any template in the project.
2. Checklist Permission: Full Control- Members can work with and archive any checklist
regardless of the creator.
3. Daily Logs Permission: Manager- Can view, edit, and publish daily logs in the
project.
4. Issue Permission- Full Control- Members can view, create, and edit all issues in a
project.
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Step 2) Working with Checklists
Enable project members to add ready to use checklists. You can import templates from BIM 360
Field classic.
You must use one of these two templates to create a checklist:
•

Account-level template: Allow a template to be shared with multiple projects. These
templates can only be edited by account administrators of the company that manages
them.

•

Project-level template: Allow for multiple checklists to be made but can only be used in
a single project. Project administrators can modify project templates.

In this case, we are using Project Level Template.
To Select Checklist Type:
Checklist types can help sort and filter checklists. The following types are available:
•

Quality: Use quality checklists to provide quality assurance checklists.

•

Punch List: Provide a list of items to complete.

•

Safety: Standard safety checklists can keep the job site safe.

•

Commissioning: Use to validating building performance for final delivery.

Using Checklist Signatures
You can require signatures for a checklist. Once all the checklist sections are done, signatures
can be required to close the checklist. Reopening a checklist deletes signatures requiring the
checklist to be resigned. Checklists are signed using Android or IOS mobile apps.
Using Checklist Sections
Sections can be reordered and have two main components:
•

Section Title: To give a beginning descriptor of the location or type of checklist.

Note: Use a section title that reflects the work but is generic enough that multiple checklists can
be made from the same template.
•

Section Description: Section descriptions can be edited before creating a checklist to
quickly make checklists that have the same items and sections.

Checklist Items
Checklist Items have a name, an optional description, and an answer type. You can make items
optional.
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The answer types can drive some of the functionality of the items and sections. The following
types are available:
•

Yes / No / NA: Creates a radio button answer field with these selections.

•

True / False / NA: Creates a radio button answer field with these selections.

•

Pass / Fail / NA: Creates a radio button answer field with these selections.

•

+ / - / NA: Creates a radio button answer field with these selections.

•

Multiple Choice: Add suitable answers and use the slider to select a non-conforming
answer. Non-conforming answers keep track of work that needs to be corrected.

•

Checkboxes: Add items boxes to check off for an item and use the slider to select nonconforming answers.

•

TEXT: Create a text field for answers to be entered in the field.

•

Numeric: Creates a field that requires a number for an answer.

Note: In this case, we will import the already created checklist template from Excel to BIM 360
Field Management.
The checklist template name is “Checklist AU 2020 Sample” (Download this template from the
class sample file)
To import a checklist template:
1. Click the Module Selector

Field Management.

2. Click the Templates tab.
3. Click Import.
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4. In the dialog, select Import Templates.

5. Click Next.
6. Click on Browse to import the excel sheet saved from the Data Set called as “Checklist
AU 2020 Sample.xls”

7. Click on Import
Note: Once you see the template in your browser, you can also edit it to add some changes in
the Template like check the sliders for:
Auto-create Issue settings.
Note: You must select an Issue type to create settings for generating automatic issues. Section
and checklist item settings can be modified.

Alternatively, if you want to create a new template without using the excel, you can refer the
document here

.
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To create a Checklist in the Web browser:
1. Go to Checklist tab
2. Click on Create Checklists

3. Select the template Checklist AU 2020 Sample and click on create.
4.

5. On the top, the title of the checklist is displayed. By default, it is same as the name of the

checklist template. You can change the title if you wish.
6. Fill the checklist created using the template
7. In Construction Check, which is Item 2, you can write “Autodesk” under Manufacturing

Company Name.
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8. Once all details are filled, a window will appear saying All sections completed.

9. Click on “Complete Checklist” to finish the creation

Note: To create checklist from ipad, you can refer the video in this link.
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Step 2) Creating Issue Template
Before creating a template, it is important to know about Issue Types and subtypes and how
they can be customized for any project.
Issue Types and Sub-Types
When working with issues, understanding root causes helps prevent them from recurring. Root
causes fall under categories, which helps you find and filter root causes.
Note: Only project administrators can create custom categories and root causes.
To know about the custom root cause, click on the help link here.
Issue templates can reduce the time required to create a frequent issue on the job site.
Templates can be used to automate the process to create an issue. Templates must include the
following:
•
•
•

Title
Issue Type
Initial Status

Other attributes can be added depending on the Issue type. These are:
•
•
•
•
•
•
•
•
•

Category
Assigned to
Due Date
Location
Location Details
Owner
Root Cause
Description
Custom Attributes

Note: To know more about Issue Types, you can refer the help document here
We will be creating Issues template, under the category called “Design”. You can understand
more about the category part from here.
To create Issue Template:
1.
2.
3.
4.

Click the Module Selector
Field Management.
Click the Issues tab.
Click the Templates secondary tab.
Click Create a new template.
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5. Under Template Category, select “Create new category”
6.

7. Create a new category called Coordination
8. Enter a title- Issues Sample AU 2020
9. Select the Issue Type as “Coordination”.
10. Keep the Initial Status as “Open”

11. Select the Root Cause as “Constructability “under Coordination.
12. Click on Create to create the Template
Note: You can add the description by your choice.
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Creating Issue using the above template:
1. In the Issues tab, click Create Issue.

2. Enter issue details in the Create New Issue dialog as below with Issue Type as
Coordination and template selected as “Issues AU 2020 Example”
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3. Set the status of the issue as Open in this case.
Note: To know more about the issue workflow and status, you can refer to the document
here.
4. Click on Create to create the issue.
5. We will select the issue and click on Attachments to attach a document.
6.
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7. Click on browse to select the document from BIM 360 Document Management

8. Select the Structural model from the Project files folder assuming that the issue is
related to that model.
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•
•

Note:
You can also add a description.
For Assigned To, you can assign by users, roles, or companies. Assignees receive an
email notification with a link to the issue.

You can also create issues from Document Management and pin them to the 2D sheets/ 3D
models using the Filed Management Issue template.
Create and manage issues related to 2D projects and 3D models, at a document or project
level.
You can work with issues in BIM 360 alone or collaborate using Navisworks. See
the Navisworks help for more information.
Note: In addition to document-based issues, you can also create issues that aren't associated
with a specific location, but with a project. The process is similar to how we create independent
issues in Field Management (Just tried above!). You can refer to this document for details.
You can also refer Issues in Document Management FAQs for additional queries.
To create an issue in 2D/ 3D model-based issues in BIM 360 Document Management:
1. Open the 3D model “Architectural model” from the Projects files folder in BIM 360

Document Management.
2. At the bottom left of the Issues panel, click Create Issue.
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3. Click a location to place the issue pushpin. A pushpin represents an issue. Drag the

pushpin to where you want to place it.

Page 38

4.

5.
6.
7.
8.

Note: The location field will automatically populate if the pushpin is placed in a defined
location. To know more about locations, refer this document.Moving the pushpin to an
undefined location will clear the location field.
Specify the issue type as “Design” and Status as “Open”
Tip: When creating an issue, you can set the issue status to Draft before saving it. When
ready to assign, set to Open.
Provide the title as ‘Issue AU 2020- Type 2”
Add the root cause as “Code compliance” under Design
Add the description. In this case we will add something like “Want to remove the panel”
Click on Create

Additional Information:
•
•
•

You can also edit project-level and document-level issues according to your needs.
You can export a complete list of project issues in PDF, or CSV format for offline review.
Note: PDF export is only available to project administrators.
The issues, both from Document Management and Field Management can be viewed in
the Issues list in both the services.

For more information on the above information, refer this document.
Note: To create issues from BIM 360 iPad, you can refer the link here.
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Step 4) BIM 360 Insights
Insight is an ecosystem that delivers unified project-level data, analytics, and predictive insights.
It can help get you up to speed with what's going on in a project, assess trends and patterns in
project data, identify any gaps and problems, and use predictive risk data to improve project
efficiency.
This is how the Insight page for the current project will look like with the data that we have
created:

There are two broad categories of Construction IQ user, each with different associated
permissions and workflows:
•

Executive (Director of Quality, VP of Operations): Can see an executive overview of all
projects in the account, which provides visibility of project and subcontractor risk and
identifies cross-project patterns.

•

Project Lead (Superintendent, Project Manager): Can see a project overview, including
the risk level for all subcontractors and issues in the project.

Note: The Construction IQ data presented in Project Home and Insight depends on your
project module access and the permissions associated with your assigned role.
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We are looking into the Project Overview side of things.
There are different tabs in the Project Insight like Risk, Design, Project Controls, Cost,
Schedule, Quality, Safety and Reports.
Risk:
Use the Risk tab to get an overview of metrics related to the current high-risk issues in your
project.
Note: The data displayed on the Risk tab is collected from Classic BIM 360 Field, and the Next
Generation Field Management and Account Admin modules, and analyzed by Construction IQ.
The Construction IQ machine learning algorithms are currently optimized for Commercial,
Healthcare, Institutional, and Residential project types. Risk analysis of issues is only carried
out in projects that use one of these project types. The project type is specified when the project
administrator creates the project.
Design:
Use the Design tab to get an overview of metrics related to design review and model
coordination processes.
The Design tab provides insights into trends and patterns around outstanding design and
coordination issues and reviews, and which companies are responsible for resolving them
Note: You must have access to Document Management to see the Design tab. The cards
displayed depend on your access to project services. For example, in order to see coordination
analytics, you need access to the Model Coordination service in BIM 360.
See the Analyze Design Review Risk topic for more information on how the cards within the
Design tab can be used to predict and prevent design issues as part of a design review.
Project Controls:
Use the Project Controls tab to get an overview of metrics related to the issues, RFIs, and
submittals associated with your project.
Note: The Project Controls tab is visible to anyone with access to Document Management, and
this allows you to see the Document Management-specific cards. Access to Project
Management allows you to additionally view the Project Management-specific cards.
Cost:
Use the Cost tab to get an overview of cost and budget trends, such as the original vs projected
budget for different aspects of your project.
Note: You must have access to Cost Management to see the Cost tab.
Schedule:
Note: The Schedule tab requires access to BIM 360 Plan.
Quality:
Use the Quality tab to get an overview of metrics related to the quality of your project.
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The Quality tab aggregates your project quality data into one view, allowing you to monitor issue
status, activity, and root cause.
Note: You must have access to Field Management to see the Quality tab. The cards displayed
depend on your access to project services and permissions associated with your role. For more
information, see Visual Workflow: Get Started with Insight.
Safety:
Use the Safety tab to get an overview of metrics related to the safety and risk of your project.
Report:
Use the Reports tab to get a quick overview of the reports exported in various BIM 360
modules, such as Document Management, Field Management, and Project Management. Gain
insight into data related to issues, checklists, documents, submittals, and RFIs. Project
administrators can also create reports using pre-defined custom templates. To learn more,
see Reports in Insight.
Additional Information
•

You can also customize the Insight Dashboard depending on what you want to see.

•

Add, remove, or rearrange cards using the Customize Dashboard in Project Home and
the tabs in Insight. For more information around it, refer: Customize Dashboards

•

For more questions on Construction IQ refer: Construction IQ FAQs
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Step 3) Data Connector and Power BI
The data connector automatically extracts data from all BIM 360 projects in your account to a
CSV file.
Note: In order to access Data Connector. One must have the Executive Overview access
enabled in account admin service.
To give executive overview follow the steps:
1.
2.
3.
4.

Go to Account Admin Page.
On the members tab, select the member and click on edit.
Select the member and click Edit on the profile.
Select Executive Overview and click on Save.

To access data connector:
1.
2.
3.
4.

Go to the account administration service.
Select Insight module.
Open the Data tab within the Insight module.
Click Run.

5. After the extraction is complete, click Download
to download a .zip file of the
extracted data.
6. The download files include project data information mentioned in this article.
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Extracted data is packaged into a downloadable .zip file containing a series of .csv files. Each
.csv file represents a different set of data for the categories listed above.
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Adding BIM 360 extracted project data in Power BI.
1. Download the Power BI template from the reference material of this hands-on lab.
2. Open the template in Power BI.
3.

4. The template will ask for a data-link address.

5. Copy-paste the file path. For example, in this case, I have downloaded the file in my
desktop folder. I will use the path:

6. The data is now visible in Power BI.
Note: The data shown in the presentation is a data for our internal test account of Autodesk.
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Learning Objective 3 – ‘Understanding of Autodesk Forge’
Forge is a cloud-based program from Autodesk. The platform offers APIs and services that help
you access and use your design and engineering data via the cloud. Integrate with the Autodesk
BIM 360 platform to extend its capabilities to reach segments of the construction ecosystem that
don’t have direct access to BIM data.
This section will cover the following learning objectives:
1. Creating a Forge application and integrating it with BIM 360 Account.
2. Understanding of Forge APIs.
3. Live demonstration of BIM 360 data extraction using Authentication and Data
Management Forge APIs.

Step 1) Create an application in Forge
1. Sign in to https://forge.autodesk.com/
2. Go to the top right corner and select the option ‘My Apps’

3. Select the option ‘Create App’.
4. It will ask to select the desired APIs.
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5.
6.
7.
8.

Select BIM 360 API.
Fill the App name and other information which are required.
Hit on ‘Create App’.
Make a note of your Client ID and Client Secret. They will be used to generate a token,
which will be appended to every request your app makes. The token lets Forge
authenticate each request and associate them with your account.

Client Id
A Client Id is sometimes called a Consumer Key. It’s a unique key – uniquely assigned to you
that allows your application to identify itself in public. It is used during the authentication (OAuth)
process, and many developers also use it as a prefix when they must generate a unique name
for something (for example when naming buckets used for file storage in the Object Storage
System).
Client Secret
The Client Secret is sometimes called a Consumer Secret Key. It is used in conjunction with the
Client Id to authenticate your application. Unlike your Client Id, you must never share your Client
Secret with anyone. (The only time you will use it is during the OAuth process). If you
accidentally do reveal it to someone, you can regenerate the Client Secret for the App from the
Forge App details screen (see image above). The advantage of regenerating your Client
Secret instead of generating a completely new App is that this allows you to retain access to the
data you have posted to the Forge platform.
Note: At any point in time, you can add or remove Forge services from your app. In today’s lab,
we are extracting the information of BIM 360 project data with help of below Forge APIs:
•
•

Authentication
Data Management
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Step 2) Add Forge application to the BIM 360 account.
Once the app is created, then you need to integrate this application with the BIM 360 Account.
Follow the below steps:
1.
2.
3.
4.

Open BIM 360 in a web browser.
Go to the ‘Account Admin’ service.
Select the Sub-tab settings
Under ‘Settings’ select Custom integration
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5. Select access:

6. Click Next.

7. Provide the required details:

8. Write down the client ID which you noted down during the app creation.
9. Click Save.
The forge application is now ready to extract BIM 360 data from your account.
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Step 3) Postman and Forge
Postman is a popular tool that provides an easy-to-use interface to send HTTP requests.
Postman can parse the responses that Forge sends and save response parameter values to
variables.
•
•

You can learn how to install and use Postman from here.
You can download the Postman installer from here.
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Step 4) Authentication (OAuth) API

•

The above is an example of understanding the basic concept of how Token-based
authentication happens in the back end.

OAuth, specifically OAuth2, is the open standard used across the Forge Platform for tokenbased authentication and authorization.

Two-Legged Authentication
This is often considered the default type of authentication, and it is the simplest. When your app
needs to call the API without having to access resources that require an end user’s permission
(for example, translating a design file from one format to another), the communication is directly
between your app and the Forge Platform. The end-user, if there is one, does not need to be
aware of the authentication or provide authorization for the app to access any resources.
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Three-legged authentication
When an app needs to access resources belonging to an end-user, that user must explicitly
provide authorization. The typical mechanism, in the case of a web app, is for the app to redirect
the user to an Autodesk login page with information about which of the user’s resources it
wishes to access. The user then provides explicit consent, letting the Forge Platform know that
the referring app is to be granted the requested access. The user is then redirected back to the
app, which can then access the required resources.
Refer API basics for more information.
We will capture the access token using Two-Legged Authentication using the OAuth API
service.
Follow below steps:
1. Open Postman
2. Create a new collection – OAuth (you can provide any other name)
3. Create a new POST Request under OAuth Collection
curl -v 'https://developer.api.autodesk.com/authentication/v1/authenticate'
-X 'POST'
-H 'Content-Type: application/x-www-form-urlencoded'
-d '
client_id=xxxxxxxxxxxxxxxxxxxxxxx
client_secret=xxxxxxxxxxxxxxxxxxxx
grant_type=client_credentials&
scope=data:read

4.

This query in Postman will look like this

5. The response of this will give you access token.
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•

Note down this access token (one can copy the token). It is recommended to
environmental variables in postman to capture the information. In this case, the
access token has been assigned to an environment variable- bearer.

Step 5) Publish a Cloud Workshared Revit Model to NextGen BIM 360 Docs Using
Data Management API
The Data Management API provides a unified and consistent way to access data across BIM
360 Team, Fusion Team (formerly known as A360 Team), BIM 360 Docs, A360 Personal, and
the Object Storage Service.
The Data Management API is composed of the following services:

This lab demonstrates how to publish the latest synchronized Cloud Workshared Revit models
to NextGen BIM 360 Docs. Each time you publish a latest model to NextGen BIM 360 Docs, you
create a new version of the model.
To publish the latest model, you need to first:
•
•
•

Initiate collaboration through Revit, and select BIM 360 Docs.
This creates the first version in BIM 360 Docs.
Modify the model locally, and synchronize the changes with the central model.

The below steps will demonstrate how to get the ID of the model that you want to update in BIM
360 Docs, publishing the model to BIM 360 Docs, and verifying that the model has finished
publishing.
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A) Find the Hub ID for the BIM 360 Account
The first few steps of the tutorial demonstrate how to iterate through several Forge Data
Management endpoints to find the ID of the cloud workshared Revit model you want to update.
Call GET hubs to find the hub ID for the BIM 360 account that contains the model you want to
update.
1) Open Postman
2) Get the Access_ token (refer: ‘Step 4) Authentication (OAuth) API’)
3) Send the below ‘GET’ request from postman.
Request:
curl -v 'https://developer.api.autodesk.com/project/v1/hubs'
'Authorization: Bearer AuIPTf4KYLTYGVnOHQ0cuolwCW2a'

-H

Note:
• The ‘ForgeURL’ is the environment variable with loaded valuedeveloper.api.autodesk.com
• Bearer is an environmental variable with the loaded value of the access token.
Response:
The response to the above query will look like:
"data": [
{
"type": "hubs",
"id": "b.ddde928d-b610-4b18-b43d-2915ad438a84",
"attributes": {
"name": "DemoAccount",
"extension": {
"type": "hubs:autodesk.bim360:Account",
"version": "1.0",

We will now note down this HUB ID of BIM 360 Account- b.ddde928d-b610-4b18-b43d2915ad438a84

B) Find the Project ID
Put the HUB ID in the below request. One can also set up the environment variable for it.
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Request:

curl -X GET -H "Authorization: Bearer nFRJxzCD8OOUr7hzBwbr06D76zAT"
"https://developer.api.autodesk.com/project/v1/hubs/b.ddde928d-b610-4b18b43d-2915ad438a84/projects?filter[attributes.name]=DemoProject"

Note:
• The ‘ForgeURL’ is the environment variable with loaded valuedeveloper.api.autodesk.com
• Bearer is an environmental variable with the loaded value of the access token.
• ‘HubId’ is the environment variable in which the ID of the HUB has been saved.
Response:
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The response to the above query will look like:
"data": [
{
"type": "projects",
"id": "b.c8112490-4e08-435c-994b-64fe60fea507",
"attributes": {
"name": "DemoProject",
"extension": {
"type": "projects:autodesk.bim360:Project",
"version": "1.0",
"schema": {
"href":
"https://developer.api.autodesk.com/schema/v1/versions/projects:autodesk.bim360
:Project-1.0"
},
"data": {}

We will now note down this Project ID of BIM 360 Project- b.c8112490-4e08-435c-994b64fe60fea507

C) Find the Folder ID:
Put the HUB ID, Project ID in the below request.
Request:

curl -X GET -H "Authorization: Bearer nFRJxzCD8OOUr7hzBwbr06D76zAT"
"https://developer.api.autodesk.com/project/v1/hubs/b.ddde928db610-4b18-b43d-2915ad438a84/projects/b.c8112490-4e08-435c-994b64fe60fea507/topFolders"

Note:
• The ‘ForgeURL’ is the environment variable with loaded valuedeveloper.api.autodesk.com
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•
•
•

‘Bearer’ is an environmental variable with the loaded value of the access token.
‘HubId’ is the environment variable in which the ID of the HUB has been saved.
‘Project ID’ is the environment variable in which the ID of the Project has been saved.

Response:
The response to the above query will look like:
"data": [
{
"type": "folders",
"id": "urn:adsk.wipprod:fs.folder:co.BJU3PTc4Sd2CmXM492XUiA",
"attributes": {
"name": "Project Files",
"displayName": "Project Files",
"createTime": "2017-06-13T05:16:18.0000000Z",
"createUserId": "38SCJGX4R4PV",
"createUserName": "John Doe",
"lastModifiedTime": "2018-02-22T17:51:11.0000000Z",
"lastModifiedUserId": "38SCJGX4R4PV",
"lastModifiedUserName": "John Doe",
"lastModifiedTimeRollup": "2018-02-22T17:58:36.0000000Z",
"objectCount": 4,

We will now note down this Folder ID urn:adsk.wipprod:fs.folder:co.BJU3PTc4Sd2CmXM492XUiA
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D) Find the Item ID of the Cloud Workshared Model
Put the Project ID and Folder ID in the below request.
Request:
curl -X GET -H "Authorization: Bearer nFRJxzCD8OOUr7hzBwbr06D76zAT"
"https://developer.api.autodesk.com/data/v1/projects/b.c8112490-4e08-435c-994b64fe60fea507/folders/urn:adsk.wipprod:fs.folder:co.BJU3PTc4Sd2CmXM492XUiA/conte
nts?filter[attributes.extension.type]=items%3Aautodesk.bim360%3AC4RModel"

Note:
• The ‘ForgeURL’ is the environment variable with loaded valuedeveloper.api.autodesk.com
• Bearer is an environmental variable with the loaded value of the access token.
• ‘Project ID’ is the environment variable in which the ID of the Project has been saved.
• ‘Folder ID’ is the environmental variable in which the ID of the folder has been saved.
Response:
The response to the above query will look like:
"data": [
{
"type": "items",
"id": "urn:adsk.wipprod:dm.lineage:hPW2BlBbQG2L5HjCOh7Z8Q",
"attributes": {
"displayName": "DemoModel",
"createTime": "2018-02-22T17:51:11.0000000Z",
"createUserId": "38SCJGX4R4PV",
"createUserName": "John Doe",
"lastModifiedTime": "2018-02-22T17:58:36.0000000Z",
"lastModifiedUserId": "38SCJGX4R4PV",
"lastModifiedUserName": "John Doe",
"hidden": false,
"reserved": false,
"extension": {
"type": "items:autodesk.bim360:C4RModel",

We will now note down this Model ID of Revit cloud work shared modelurn:adsk.wipprod:dm.lineage:hPW2BlBbQG2L5HjCOh7Z8Q
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E) Publish the Latest Version of the Model to BIM 360 Docs
Put the Project ID, Folder ID in the below request.
Request:

curl -X POST -H "Authorization: Bearer nFRJxzCD8OOUr7hzBwbr06D76zAT"
"https://developer.api.autodesk.com/data/v1/projects/b.c8112490-4e08-435c-994b64fe60fea507/commands" -H 'content-type: application/vnd.api+json' -d '
{
"jsonapi": {
"version": "1.0"
},
"data": {
"type": "commands",
"attributes": {
"extension": {
"type": "commands:autodesk.bim360:C4RModelPublish",
"version": "1.0.0"
}
},
"relationships": {
"resources": {
"data": [ { "type": "items", "id": "urn:adsk.wipprod:dm.lineage:hPW2BlBbQG2L5HjCOh7Z8Q"
} ]
}
}
}
}'

Headers:
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Body:

Note:
• The ‘ForgeURL’ is the environment variable with loaded valuedeveloper.api.autodesk.com
• Authorization must be Bearer <token>, where <token> is obtained via either a twolegged or three-legged OAuth flow. Note that it will not accept a two-legged token unless
you add the x-user-id header.
o x-user-id: In a two-legged authentication context, the app has access to all users
specified by the administrator in the SaaS integrations UI. By providing this
header, the API call will be limited to act on behalf of only the user-specified.
• Content-Type- Must be application/vnd.api+json.
• ‘Project ID’ is the environment variable in which the ID of the HUB has been saved.
• Folder ID is the environmental variable in which the ID of the folder has been saved.
Response:
The response to the above query will look like:
{
"jsonapi": {
"version": "1.0"
},
"data": {
"type": "commands",
"id": "971ee7a6-5737-483a-bc64-31a88aae09b3_3_636549189940000000",
"attributes": {
"status": "committed",
"extension": {
"type": "commands:autodesk.bim360:C4RModelPublish",
"version": "1.0.0"

We will now note down this Model ID of Revit cloud work shared modelurn:adsk.wipprod:dm.lineage:hPW2BlBbQG2L5HjCOh7Z8Q
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F) Verify the Model Has Finished Publishing
Use the project ID (b.c8112490-4e08-435c-994b-64fe60fea507) and item ID
(urn:adsk.wipprod:dm.lineage:hPW2BlBbQG2L5HjCOh7Z8Q) to iteratively call GET
projects/:project_id/items/:item_id, which returns the extraction status of the latest (tip) version
of the model.
When included[i].data.extractState is set to SUCCESS, the model has finished
publishing.
Request:
curl -X GET -H "Authorization: Bearer nFRJxzCD8OOUr7hzBwbr06D76zAT"
"https://developer.api.autodesk.com/data/v1/projects/b.c8112490-4e08-435c-994b64fe60fea507/items/urn:adsk.wipprod:dm.lineage:hPW2BlBbQG2L5HjCOh7Z8Q"

Note:
• The ‘ForgeURL’ is the environment variable with loaded valuedeveloper.api.autodesk.com
• Bearer is an environmental variable with loaded value of the access token.
• ‘Project ID’ is the environment variable in which the ID of the Project has been saved.
• ‘Folder ID’ is the environmental variable in which the ID of the folder has been saved.
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Response:
The response to the above query will look like:
"data": {
"modelVersion": 4,
"projectGuid": "cb5b9d79-a68a-4d35-adf6-dc824248f698",
"originalItemUrn":
"urn:adsk.wipprod:dm.lineage:hPW2BlBbQG2L5HjCOh7Z8Q",
"isCompositeDesign": false,
"modelType": "multiuser",
"latestEpisodeGuid": "bb57cf74-0e5c-459c-9271-5b421f9fc886",
"mimeType": "application/vnd.autodesk.r360",
"modelGuid": "971ee7a6-5737-483a-bc64-31a88aae09b3",
"compositeParentFile": "",
"processState": "PROCESSING_COMPLETE",
"extractionState": "SUCCESS",
"splittingState": "NOT_SPLIT",
"reviewState": "NOT_IN_REVIEW",
"revisionDisplayLabel": "4"
}

After the model gets successfully published. The extractionState should return value as
“Success”.

`
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Learning Objective 4 – ‘Future of cloud technology’
As we have reached the last section of this class, it is important to summarize what we have
learned till now.
From the era of the stone age to the era of the cloud age, the construction industry has evolved
drastically. Let us take a step back to acknowledge technological innovations and their impact
on design and construction. The future looks exciting, considering the fact that now we have
cloud-connected data. We have reached a stage where we can create customized applications
that can help us achieve our goals at a faster pace.
But we are still developing. Every day we hear customer stories that inspire us, that make us
believe that there is much more that can be done using the technology in hand.
This is why, we want to keep this last objective as an open forum where we would like to hear
from you, what you think about the future of design and construction. Feel free to provide
feedback, drop a comment, or write to us personally to discuss any of the following:
1.
2.
3.
4.

How would you like to use the learnings from this class in your upcoming projects?
What are your thoughts about using this technology more efficiently?
Do you feel this change exciting?
What are the challenges that recent innovations have removed? ( an experience which
you want to share).

Please share your ideas with us in the comments box or the live Q/A session, so that, as an
industry, we can all work on it together. You can also find us on Linked in for further discussion.
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Conclusion:
Thank you all for attending the class. We are glad that you were able to take out time to listen to
our recording and have a look at our handout as well.
At the end of the class, I would like to revisit the learning objectives, which were:
•
1)
2)
3)

BIM 360 Design workflow, where we covered:
Creating BIM 360 project and setting up teams
Collaborating Revit model with BIM 360
Using BIM 360 Design workflow to share/ consume data from other teams.

•
1)
2)
3)

Integration of Design and Construction, where we covered:
Use of BIM 360 Field Management to create checklists and issues
Overview of Construction IQ which uses this data to manage risk and improve performance.
Use of Data Connector to import the BIM 360 data to Power BI for data analysis

•
1)
2)
3)

Understanding of Autodesk Forge, where we covered:
Creating a Forge application and integrating it with BIM 360 Account.
Understanding of Forge APIs.
Live demonstration of BIM 360 data extraction using Authentication and Data Management
Forge APIs.

•

Future of cloud technology, which is an open-end to this hands-on lab, waiting for ideas
and feedback.

I am hopeful that each one of you has learned something new from our class.
As mentioned before, please feel free to provide comments and feedback on the AU page
and, in the live Q/ A session.
I would like to end the class with a quote:
“The future depends on what you do today.” - Mahatma Gandhi
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